HP Deskjet D1600 Printer series
# Contents

1  How Do I? ........................................................................................................................................3

2  Get to know the HP Printer
   Printer parts .........................................................................................................................................5

3  Print
   Print documents ..................................................................................................................................7
   Print photos .........................................................................................................................................8
   Print envelopes ....................................................................................................................................10
   Print on specialty media ........................................................................................................................11
   Print a Web page ..................................................................................................................................17

5  Work with cartridges
   Check the estimated ink levels .............................................................................................................25
   Order ink supplies .................................................................................................................................26
   Automatically clean print cartridges ....................................................................................................27
   Manually clean print cartridges .............................................................................................................27
   Replace the cartridges .............................................................................................................................29
   Use ink-backup mode ...............................................................................................................................31
   Cartridge warranty information ............................................................................................................31

6  Solve a problem
   HP support .........................................................................................................................................33
   Setup troubleshooting .............................................................................................................................34
   Print troubleshooting ...............................................................................................................................38
   Errors ....................................................................................................................................................42

8  Technical information
   Notice ...................................................................................................................................................49
   Specifications .........................................................................................................................................49
   Environmental product stewardship program .........................................................................................50
   Regulatory notices .................................................................................................................................53
   Index ....................................................................................................................................................57
1 How Do I?

Learn how to use your HP Printer

- Load media
- Replace the cartridges
2 Get to know the HP Printer

- Printer parts

Printer parts

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On button</td>
</tr>
<tr>
<td>2</td>
<td>Paper tray</td>
</tr>
<tr>
<td>3</td>
<td>Paper tray extender (also referred to as the tray extender)</td>
</tr>
<tr>
<td>4</td>
<td>Front access door</td>
</tr>
<tr>
<td>5</td>
<td>Print cartridges</td>
</tr>
<tr>
<td>6</td>
<td>Cartridge access area</td>
</tr>
<tr>
<td>7</td>
<td>USB port</td>
</tr>
<tr>
<td>8</td>
<td>Rear access door</td>
</tr>
<tr>
<td>9</td>
<td>Power connection: Use only with the power adapter supplied by HP</td>
</tr>
</tbody>
</table>
Chapter 2

Get to know the HP Printer
Choose a print job to continue.

- **Print documents**
- **Print photos**
- **Print envelopes**
- **Print on specialty media**
- **Print a Web page**

**Related topics**
- Load media
- Recommended papers for printing

---

### Print documents

Most print settings are automatically handled by the software application. You need to change the settings manually only when you change print quality, print on specific types of paper or transparency film, or use special features.

**To print from a software application**
1. Make sure you have paper loaded in the paper tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. If you need to change settings, click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.

**NOTE:** When printing a photo, you must select options for the specific photo paper and photo enhancement.
5. Select the appropriate options for your print job by using the features available in the Advanced, Printing Shortcuts, Features, and Color tabs.

\[\text{TIP: You can easily select the appropriate options for your print job by choosing one of the predefined print tasks on the Printing Shortcuts tab. Click a type of print task in the Printing Shortcuts list. The default settings for that type of print task are set and summarized on the Printing Shortcuts tab. If necessary, you can adjust the settings here and save your custom settings as a new printing shortcut. To save a custom printing shortcut, select the shortcut and click Save As. To delete a shortcut, select the shortcut and click Delete.}\]

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.

Related topics
- Recommended papers for printing
- Load media
- View the print resolution
- Create custom printing shortcuts
- Set the default print settings
- Stop the current job

Print photos

To print a photo on photo paper
1. Remove all paper from the paper tray, and then load the photo paper print side down.

![Photo paper](image)

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Basic Options area, select the appropriate photo paper type from the Paper Type drop-down list.
7. In the Resizing Options area, click the appropriate paper size from the Size list. If the paper size and paper type are not compatible, the product software displays an alert and allows you to select a different type or size.
8. In the **Basic Options** area, select a high print quality, such as **Best**, from the **Print Quality** drop-down list.

**NOTE:** For maximum dpi resolution, go to the **Advanced** tab, and then select **Enabled** from the **Maximum dpi** drop-down list. For more information, see **Print using the maximum dpi**.

9. Click **OK** to return to the **Properties** dialog box.

10. (Optional) If you want to print the photo in black and white, click the **Color** tab and select the **Print in grayscale** check box. From the drop-down list, select one of the following options:
   - **High Quality**: uses all the available colors to print your photo in grayscale. This creates smooth and natural shades of gray.
   - **Black Ink Only**: uses black ink to print your photo in grayscale. The gray shading is created by varying patterns of black dots, which might result in a grainy image.

11. Click **OK**, and then click **Print** or **OK** in the **Print** dialog box.

**NOTE:** Do not leave unused photo paper in the paper tray. The paper might start to curl, which could reduce the quality of your printout. Photo paper should be flat before printing.

### To print a borderless image

**NOTE:** To print borderless photos, use 4 x 6 inch photo paper with a 0.5 inch tab (10 x 15 cm with 1.25 cm tab). The photo prints without borders on three sides and with a small border on the bottom edge that you tear off to make the photo completely borderless.

1. Remove all paper from the paper tray.
2. Place the photo paper print side down on the right side of the paper tray.
3. On the **File** menu in your software application, click **Print**.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.

6. Click the Features tab.

7. In the Size list, click the size of photo paper loaded in the paper tray. If a borderless image can be printed on the specified size, the Borderless printing check box is enabled.

8. In the Paper Type drop-down list, click More, and then select the appropriate paper type.

   **NOTE:** You cannot print a borderless image if the paper type is set to Plain paper or to a type of paper other than a photo paper.

9. Select the Borderless printing check box if it is not already checked. If the borderless paper size and paper type are not compatible, the product software displays an alert and allows you to select a different type or size.

10. Click OK, and then click Print or OK in the Print dialog box. If you printed on photo paper with a tear-off tab, remove the tab to make the document completely borderless.

   **NOTE:** Do not leave unused photo paper in the paper tray. The paper might start to curl, which could reduce the quality of your printout. Photo paper should be flat before printing.

**Related topics**
- Load media
- Print using the maximum dpi
- View the print resolution
- Create custom printing shortcuts
- Set the default print settings
- Stop the current job

**Print envelopes**

You can load one or more envelopes into the paper tray of the HP Printer. Do not use shiny or embossed envelopes or envelopes that have clasps or windows.

   **NOTE:** For specific details on how to format text for printing on envelopes, consult the help files in your word processing software. For best results, consider using a label for the return address on envelopes.
To print envelopes
1. Slide the paper-width guide all the way to the left.
2. Place the envelopes in the right side of the tray. The side to be printed on should face down. The flap should be on the left side.
3. Push the envelopes into the printer until they stop.
4. Slide the paper-width guide firmly against the edge of the envelopes.
5. Open the Printer Properties dialog box.
6. Click the Features tab, and then select the following print settings:
   - **Paper Type**: Plain paper
   - **Size**: An appropriate envelope size
7. Select any other print settings that you want, and then click **OK**.

**Related topics**
- Load media
- View the print resolution
- Create custom printing shortcuts
- Set the default print settings
- Stop the current job

Print on specialty media

**Print transparencies**
1. Slide the paper-width guide all the way to the left.
2. Place the transparencies in the right side of the tray. The side to be printed should face down and the adhesive strip should face up and toward the printer.
3. Carefully push the transparencies into the printer until they stop, so that the adhesive strips do not catch on one another.
4. Slide the paper-width guide firmly against the edge of the transparencies.

5. Open the **Printer Properties** dialog box.
6. Click the **Printing Shortcuts** tab.
7. In the **Printing Shortcuts** list, click **Presentation Printing**, and then specify the following print settings:
   - **Paper Type**: Click **More**, and then select an appropriate transparency film.
   - **Paper Size**: An appropriate paper size
8. Select any other print settings that you want, and then click **OK**.

**Print postcards**
1. Slide the paper-width guide all the way to the left.
2. Place the cards in the right side of the tray. The side to be printed on should face down and the short edge should point toward the printer.
3. Push the cards into the printer until they stop.
4. Slide the paper-width guide firmly against the edge of the cards.

5. Open the **Printer Properties** dialog box.
6. Click the **Features** tab, and then specify the following print settings:
   - **Paper Type**: Click **More**, click **Specialty Papers**, and then select an appropriate card type.
   - **Print Quality**: **Normal** or **Best**
   - **Size**: An appropriate card size
7. Select any other print settings that you want, and then click **OK**.

**Print labels**
1. Slide the paper-width guide all the way to the left.
2. Fan the edges of the label sheets to separate them, and then align the edges.
3. Place the label sheets in the right side of the tray. The label side should face down.
4. Push the sheets into the printer until they stop.
5. Slide the paper-width guide firmly against the edge of the sheets.

6. Open the **Printer Properties** dialog box.
7. Click the **Printing Shortcuts** tab.
8. In the **Printing Shortcuts** list, click **General Everyday Printing**, and then specify the following print settings:
   - **Paper Type**: Plain Paper
   - **Paper Size**: An appropriate paper size
9. Click **OK**.

**Print brochures**

1. Slide the paper-width guide all the way to the left.
2. Place the paper in the right side of the tray. The side to be printed on should face down.
3. Push the paper into the printer until it stops.
4. Slide the paper-width guide firmly against the edge of the paper.

5. Open the **Printer Properties** dialog box.
6. Click the **Features** tab.
7. Specify the following print settings:
   - **Print Quality**: Best
   - **Paper Type**: Click More, and then select an appropriate HP inkjet paper.
   - **Orientation**: Portrait or Landscape
• **Size**: An appropriate paper size
• **Two-sided printing**: Manual

8. Click **OK** to print.

**Print greeting cards**

1. Slide the paper-width guide all the way to the left.
2. Fan the edges of the greeting cards to separate them, and then align the edges.
3. Place the greeting cards in the right side of the tray. The side to be printed on should face down.
4. Push the cards into the printer until they stop.
5. Slide the paper-width guide firmly against the edge of the cards.

6. Open the **Printer Properties** dialog box.
7. Click the **Features** tab, and then specify the following print settings:
   • **Print Quality**: Normal
   • **Paper Type**: Click **More**, and then select an appropriate card type.
   • **Size**: An appropriate card size
8. Select any other print settings that you want, and then click **OK**.

**Print booklets**

1. Slide the paper-width guide all the way to the left.
2. Place plain paper in the right side of the tray. The side to be printed on should face down.
3. Push the paper into the printer until it stops.
4. Slide the paper-width guide firmly against the edge of the paper.

5. Open the **Printer Properties** dialog box.
6. Click the **Printing Shortcuts** tab.
7. In the **Printing Shortcuts** list, click **Booklet Printing**.
8. In the **Print On Both Sides** drop-down list, select one of the following binding options:
   - Left Edge Booklet
   - Right Edge Booklet
9. Select any other print settings that you want, and then click **OK**.
10. When prompted, reload the printed pages in the paper tray as shown below.

11. Click **Continue** to finish printing the booklet.

**Print posters**
1. Slide the paper-width guide all the way to the left.
2. Place plain paper in the right side of the tray. The side to be printed on should face down.
3. Push the paper into the printer until it stops.
4. Slide the paper-width guide firmly against the edge of the paper.
5. Open the **Printer Properties** dialog box.
6. Click the **Features** tab, and then specify the following print settings:
   - **Paper Type**: Plain Paper
   - **Orientation**: Portrait or Landscape
   - **Size**: An appropriate paper size
7. Click the **Advanced** tab, and then click **Printer Features**.
8. In the **Poster Printing** drop-down list, select the number of sheets for the poster.
9. Click the **Select Tiles** button.
10. Check that the number of tiles that are selected matches the number of sheets for the poster, and then click **OK**.

11. Select any other print settings that you want, and then click **OK**.

**Print iron-on transfers**
1. Slide the paper-width guide all the way to the left.
2. Place the iron-on transfer paper in the right side of the tray. The side to be printed on should face down.

3. Push the paper into the printer until it stops.
4. Slide the paper-width guide firmly against the edge of the paper.

5. Open the **Printer Properties** dialog box.
6. Click the Features tab, and then specify the following print settings:
   • Print Quality: Normal or Best
   • Paper Type: Click More, click Specialty Papers, and then click Other specialty paper.
   • Size: An appropriate paper size

7. Click the Advanced tab.

8. Click Printer Features, and then set Mirror Image to On.

   **NOTE:** Some iron-on transfer software programs do not require you to print a mirror image.

9. Select any other print settings that you want, and then click OK.

**Related topics**
- Recommended papers for printing
- Load media
- View the print resolution
- Create custom printing shortcuts
- Set the default print settings
- Stop the current job

**Print a Web page**

You can print a Web page from your Web browser on the HP Printer.

If you use Internet Explorer (6.0 or higher) or Firefox (2.0 or higher) for Web browsing, you can use HP Smart Web Printing to ensure simple, predictable web printing with control over what you want and how you want it printed. You can access HP Smart Web Printing from the toolbar in Internet Explorer. For more information about HP Smart Web Printing, see the help file provided with it.

**To print a Web page**

1. Make sure you have paper loaded in the paper tray.
2. On the File menu in your Web browser, click Print.

   **TIP:** For best results, select HP Smart Web Printing on the File menu. A check mark appears when it is selected.

   The Print dialog box appears.

3. Make sure the product is the selected printer.
4. If your Web browser supports it, select the items on the Web page that you want to include in the printout.
   For example, in Internet Explorer, click the Options tab to select options such as As laid out on screen, Only the selected frame, and Print all linked documents.
5. Click Print or OK to print the Web page.

   **TIP:** To print Web pages correctly, you might need to set your print orientation to Landscape.
Print using the maximum dpi

Use maximum dpi mode to print high-quality, sharp images.

To get the most benefit from maximum dpi mode, use it to print high-quality images such as digital photographs. When you select the maximum dpi setting, the printer software displays the optimized dots per inch (dpi) that the HP Printer printer will print. Printing in maximum dpi is supported on the following paper-types only:

- HP Premium Plus Photo Paper
- HP Premium Photo Paper
- HP Advanced Photo Paper
- Photo Hagaki

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk space.

To print in Maximum dpi mode

1. Make sure you have paper loaded in the paper tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
5. Click the Advanced tab.
6. In the Features area, select the Enable maximum dpi setting check box.
7. Click the Features tab.
8. In the Paper Type drop-down list, click More, and then select the appropriate paper type.
9. In the Print Quality drop-down list, click Maximum dpi.

\[\text{NOTE: To find out what dpi the product will print based on the paper type and print quality settings you selected, click Resolution.}\]

10. Select any other print settings that you want, and then click OK.
View the print resolution

The printer software displays the print resolution in dots per inch (dpi). The dpi varies according to the paper type and print quality that you select in the printer software.

To view the print resolution
1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.
3. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
4. Click the Features tab.
5. In the Paper Type drop-down list, select the type of paper that you have loaded.
6. In the Print Quality drop-down list, select the appropriate print quality setting for your project.
7. Click the Resolution button to view the print resolution dpi for the paper type and print quality combination you selected.

Create custom printing shortcuts

Use printing shortcuts to print with print settings that you use often. The printer software has several specially designed printing shortcuts that are available in the Printing Shortcuts list.

NOTE: When you select a printing shortcut the appropriate printing options are automatically displayed. You can leave them as is, change them, or create your own shortcuts for commonly used tasks.

Use the Printing Shortcuts tab for the following print tasks:

- **General Everyday Printing**: Print documents quickly.
- **Paper-saving Printing**: Print two-sided documents with multiple pages on the same sheet to reduce paper usage.
- **Photo Printing—With White Borders**: Print a photo with a white border around the edges.
- **Fast/Economical Printing**: Produce draft-quality printouts quickly.
- **Presentation Printing**: Print high-quality documents, including letters and transparencies.

To create a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.
3. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click a printing shortcut. The print settings for the selected printing shortcut are displayed.
6. Change the print settings to those you want in the new printing shortcut.
7. Click Save as and type a name for the new printing shortcut, and then click Save. The printing shortcut is added to the list.

To delete a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.
3. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click the printing shortcut that you want to delete.
6. Click Delete. The printing shortcut is removed from the list.

NOTE: Only the shortcuts that you have created can be deleted. The original HP shortcuts cannot be deleted.

Set the default print settings

If there are settings that you frequently use for printing, you might want to make them the default print settings so they are already set when you open the Print dialog box from within your software application.

To change the default print settings
1. In the HP Solution Center, click Settings, point to Print Settings, and then click Printer Settings.
2. Make changes to the print settings, and click OK.
4 Paper basics

You can load many different types and sizes of paper in the HP Printer, including letter or A4 paper, photo paper, transparencies, and envelopes.

This section contains the following topics:
Load media

Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Advanced Photo Paper
This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x 18 cm (5 x 7 inch), and two finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper
Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. It is available in semi-gloss finish in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch) (with or without tabs). For longer-lasting photos, it is acid-free.

HP Brochure Paper or HP Superior Inkjet Paper
These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars.

HP Premium Presentation Paper or HP Professional Paper
These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and newsletters. They are heavyweight for an impressive look and feel.

HP Bright White Inkjet Paper
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.

HP Printing Paper
HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more substantial than documents printed on standard multipurpose or copy
Paper. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

**HP Office Paper**
HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other everyday documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

**HP Iron-On Transfers**
HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution for creating custom T-shirts from your digital photos.

**HP Premium Inkjet Transparency Film**
HP Premium Inkjet Transparency Film make your color presentations vivid and even more impressive. This film is easy to use and handle and dries quickly without smudging.

**HP Photo Value Pack**
HP Photo Value Packs conveniently package original HP cartridges and HP Advanced Photo Paper to save you time and take the guesswork out of printing affordable professional photos with your HP Printer. Original HP inks and HP Advanced Photo Paper have been designed to work together so your photos are long lasting and vivid, print after print. Great for printing out an entire vacation’s worth of photos or multiple prints to share.

**ColorLok**
HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

To order HP papers and other supplies, go to [www.hp.com/buy/supplies](http://www.hp.com/buy/supplies). If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.

**NOTE:** At this time, some portions of the HP Web site are available in English only.
Load media

1. Select a paper size to continue.

Load small-size paper
a. Prepare tray.
   - Slide paper-width guide to the left.
   - Remove all paper from the paper tray.

b. Load paper.
   - Insert stack of photo paper into paper tray with short edge forward and print side down.
   - Slide stack of paper forward until it stops.

   **NOTE:** If the photo paper you are using has perforated tabs, load photo paper so that tabs are closest to you.

   - Slide paper-width guide to the right until it stops at edge of paper.

Load full-size paper
a. Prepare tray.
   - Slide paper-width guide to the left.
   - Remove all paper from the paper tray.

b. Load paper.
   - Insert stack of paper into paper tray with short edge forward and print side down.
   - Slide stack of paper forward until it stops.
   - Slide paper-width guide to the right until it stops at edge of paper.
Load envelopes

a. Prepare tray.
   - Slide paper-width guide to the left.
   - Remove all paper from the paper tray.

b. Load envelopes.
   - Insert one or more envelopes into far-right side of the paper tray, with envelope flaps on left and facing up.
   - Slide stack of envelopes forward until it stops.
   - Slide paper-width guide to the right against stack of envelopes until it stops.

2. View the animation for this topic.
5 Work with cartridges

- Check the estimated ink levels
- Order ink supplies
- Automatically clean print cartridges
- Manually clean print cartridges
- Replace the cartridges
- Use ink-backup mode
- Cartridge warranty information

Check the estimated ink levels

You can easily check the ink supply level to determine how soon you might need to replace a cartridge. The ink supply level shows an estimate of the amount of ink remaining in the cartridges.

**NOTE:** If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another printer, the ink level indicator might be inaccurate or unavailable.

**NOTE:** Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not have to replace the cartridges until the print quality is unacceptable.

**NOTE:** Ink from the cartridges is used in the printing process in a number of different ways, including in the initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it is used. For more information, see [www.hp.com/go/inkusage](http://www.hp.com/go/inkusage).

**To check the ink levels from the HP Photosmart Software**

1. In the HP Solution Center, click **Settings**, point to **Print Settings**, and then click **Printer Toolbox**.

   **NOTE:** You can also open the Printer Toolbox from the **Print Properties** dialog box. In the **Print Properties** dialog box, click the **Features** tab, and then click the **Printer Services** button.

   The Printer Toolbox appears.

2. Click the **Estimated Ink Level** tab. The estimated ink levels for the ink cartridges appear.

**Related topics**

Order ink supplies
Order ink supplies

For a list of cartridge numbers, use the software that came with the HP Printer to find out the reorder number.

Find the cartridge number
1. In the HP Solution Center, click Settings, point to Print Settings, and then click Printer Toolbox.

   NOTE: You can also open the Printer Toolbox from the Print Properties dialog box. In the Print Properties dialog box, click the Features tab, and then click the Printer Services button.

   The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.
   The estimated ink levels for the print cartridges appear. Use the menu at the bottom to select Cartridge details.

To order genuine HP supplies for the HP Printer, go to www.hp.com/buy/supplies. If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.

   NOTE: Ordering cartridges online is not supported in all countries/regions. If it is not available in your country/region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.

To order ink cartridges from your desktop

▲ To learn which HP supplies work with your printer, order supplies online, or create a printable shopping list, open HP Solution Center and select the online shopping feature.
   Cartridge information and links to online shopping also appear on ink alert messages. In addition, you can find cartridge information and order online by visiting www.hp.com/buy/supplies.

   NOTE: Ordering cartridges online is not supported in all countries/regions. If it is not available in your country/region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.

Related topics
Choose the right cartridges

Choose the right cartridges

HP recommends that you use original HP cartridges. Original HP cartridges are designed and tested with HP printers to help you easily produce great results, time after time.

Related topics
Order ink supplies
Automatically clean print cartridges

If your printed pages are faded or if they contain ink streaks, the print cartridges might be low on ink or might need to be cleaned. For more information, see Check the estimated ink levels.

If the print cartridges are not low on ink, clean the print cartridges automatically.
If your documents are still faded after cleaning, manually clean the print cartridge contacts. For more information, see Manually clean print cartridges.

⚠️ CAUTION: Clean print cartridges only when necessary. Unnecessary cleaning wastes ink and shortens the life of the cartridge.

To clean the print cartridges
1. In the HP Solution Center, click Settings. In the Print Settings area, click Printer Toolbox.
2. Click Clean the Print Cartridges.
3. Click Clean, and then follow the onscreen instructions.

Manually clean print cartridges

You should Automatically clean print cartridges before you try to clean the print cartridge contacts on the print cartridge(s) that are experiencing the problem.

Make sure you have the following materials available:

• Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or leave fibers.

💡 TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

• Distilled, filtered, or bottled water (tap water might contain contaminants that can damage the print cartridges).

⚠️ CAUTION: Do not use platen cleaners or alcohol to clean the print cartridge contacts. These can damage the print cartridge or the product.

To clean the print cartridge contacts
1. Turn on the product and open the print cartridge door. The print carriage moves to the center of the product.
2. Wait until the print carriage is idle and silent, and then unplug the power cord from the back of the product.
3. Lightly press down on the print cartridge to release it, and then pull it towards you out of the slot.

🔍 NOTE: Do not remove both print cartridges at the same time. Remove and clean each print cartridge one at a time. Do not leave a print cartridge outside the HP Printer for more than 30 minutes.

4. Inspect the print cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any excess water from it.

6. Hold the print cartridge by its sides.

7. Clean only the copper-colored contacts. Allow the print cartridges to dry for approximately ten minutes.

8. Hold the print cartridge with the HP logo on top, and insert the print cartridge back into the slot. Make sure you push the print cartridge in firmly until it snaps into place.

9. Repeat if necessary for the other print cartridge.

10. Gently close the print cartridge door and plug the power cord into the back of the product.
Replace the cartridges

To replace the cartridges
1. Check that power is on.
2. Remove cartridge.
   a. Open cartridge door.

   Wait for print carriage to move to center of the product.
   b. Press down to release cartridge, then remove it from slot.

3. Insert new cartridge.
   a. Remove cartridge from packaging.
b. Remove plastic tape using pink pull tab.

c. Line up colored shaped icons, then slide cartridge into slot until it clicks into place.

d. Close cartridge door.

4. View the animation for this topic.

Related topics
• Choose the right cartridges
• Order ink supplies
Use ink-backup mode

Use the ink-backup mode to operate the HP Printer with only one print cartridge. The ink-backup mode is initiated when a print cartridge is removed from the print cartridge carriage. During ink-backup mode, the product can only print jobs from the computer.

**NOTE:** When the HP Printer operates in ink-backup mode, a message is displayed on screen. If the message is displayed and two print cartridges are installed in the product, verify that the protective piece of plastic tape has been removed from each print cartridge. When plastic tape covers the print cartridge contacts, the product cannot detect that the print cartridge is installed.

Cartridge warranty information

The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the product.
6 Solve a problem

This section contains the following topics:

- HP support
- Setup troubleshooting
- Print troubleshooting
- Errors

HP support

- Support process
- HP support by phone
- Additional warranty options

Support process

If you have a problem, follow these steps:

1. Check the documentation that came with the product.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to all HP customers. It is the fastest source for up-to-date product information and expert assistance and includes the following features:
   - Fast access to qualified online support specialists
   - Software and driver updates for the product
   - Valuable product and troubleshooting information for common problems
   - Proactive product updates, support alerts, and HP newsgrams that are available when you register the product
3. Call HP support. Support options and availability vary by product, country/region, and language.

HP support by phone

Phone support options and availability vary by product, country/region, and language.

This section contains the following topics:

- Phone support period
- Placing a call
- Support phone numbers
- After the phone support period

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support. Standard phone company charges apply.
Placing a call
Call HP support while you are in front of the computer and the product. Be prepared to provide the following information:

- Product name (HP Deskjet D1600 Printer series)
- Serial number (located on the back or bottom of the product)
- Messages that appear when the situation occurs
- Answers to these questions:
  - Has this situation happened before?
  - Can you re-create it?
  - Did you add any new hardware or software to your computer at about the time that this situation began?
  - Did anything else occur prior to this situation (such as a thunderstorm, product was moved, etc.)?

Support phone numbers
For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call the support phone number for your country/region to learn more about support options.

Additional warranty options
Extended service plans are available for the HP Printer at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the services and warranty area for information about the extended service plans.

Setup troubleshooting
This section contains setup troubleshooting information for the product.

Many issues are caused when the product is connected to the computer using a USB cable before the HP Photosmart software is installed on the computer. If you connected the product to your computer before the software installation screen prompts you to do so, you must follow these steps:

Troubleshooting common setup issues
1. Disconnect the USB cable from the computer.
2. Uninstall the software (if you have already installed it).
   For more information, see Uninstall and reinstall the software.
3. Restart your computer.
4. Turn off the product, wait one minute, then restart it.
5. Reinstall the HP Photosmart software.

⚠️ CAUTION: Do not connect the USB cable to the computer until prompted by the software installation screen.

This section contains the following topics:
- The product will not turn on
- After setting up the product, it does not print
- The registration screen does not appear
- Uninstall and reinstall the software

The product will not turn on

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.
- Solution 1: Make sure the power cord is connected
- Solution 2: Press the On button more slowly

Solution 1: Make sure the power cord is connected

Solution:
- Make sure the power cord is firmly connected to both the product and the power adapter. Plug the power cord into a power outlet, surge protector, or power strip.

1. Power connection
2. Power cord and adapter

- If you are using a power strip, make sure the power strip is on. Or, try plugging the product directly into a power outlet.
- Test the power outlet to make sure it is working. Plug in an appliance that you know works, and see if the appliance has power. If not, then there might be a problem with the power outlet.
- If you plugged the product into a switched outlet, make sure the outlet is switched on. If it is switched to on but still does not work, then there might be a problem with the power outlet.
Cause: The product was not properly connected to a power supply. If this did not solve the issue, try the next solution.

---

**Solution 2: Press the On button more slowly**

**Solution:** The product might not respond if you press the On button too quickly. Press the On button once. It might take a few minutes for the product to turn on. If you press the On button again during this time, you might turn the product off.

⚠️ **CAUTION:** If the product still does not turn on, it might have a mechanical failure. Unplug the product from the power outlet.

Contact HP support for service.

Go to: [www.hp.com/support](http://www.hp.com/support). If prompted, choose your country/region, and then click Contact HP for information on calling for technical support.

---

Cause: You pressed the On button too quickly.

---

**After setting up the product, it does not print**

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

- **Step 1:** Press the On button to turn on the product
- **Step 2:** Set your product as the default printer
- **Step 3:** Check the connection between the product and computer

### Step 1: Press the On button to turn on the product

**Solution:** Look at the On button located on the product. If it is not lit, the product is turned off. Make sure the power cord is firmly connected to the product and plugged into a power outlet. Press the On button to turn on the product.

**Cause:** The product might not have been turned on.

If this did not solve the issue, try the next solution.

---

### Step 2: Set your product as the default printer

**Solution:** Use the system tools on your computer to change your product to be the default printer.

**Windows Vista users**

1. On the Windows taskbar, click **Start**, and then click **Control Panel**.
2. Click **Printers**.
3. Right-click the HP Printer icon, and then click **Set as default printer**.
Windows XP users
1. On the Windows taskbar, click **Start**, and then click **Printers and Faxes**.
2. Right-click the HP Printer icon, and then click **Set as Default Printer**.

Windows 2000 users
1. On the Windows taskbar, click **Start**, point to **Settings**, and then click **Printers**.
2. Right-click the HP Printer icon, and then click **Set as Default Printer**.

**Cause:** You sent the print job to the default printer, but this product was not the default printer.

If this did not solve the issue, try the next solution.

---

**Step 3: Check the connection between the product and computer**

**Solution:** Check the connection between the product and computer.

**Cause:** The product and computer were not communicating with each other.

---

**The registration screen does not appear**

**Solution:** You can access the registration (Sign up now) screen from the Windows taskbar by clicking **Start**, pointing to **Programs** or **All Programs**, **HP, Deskjet D1600 series**, and then clicking **Product Registration**.

**Cause:** The registration screen did not launch automatically.

---

**Uninstall and reinstall the software**

If your installation is incomplete, or if you connected the USB cable to the computer before prompted by the software installation screen, you might need to uninstall and then reinstall the software. Do not simply delete the HP Printer application files from your computer. Make sure to remove them properly using the uninstall utility provided when you installed the software that came with the HP Printer.

**To uninstall and reinstall the software**
1. On the Windows taskbar, click **Start, Settings, Control Panel** (or just **Control Panel**).
2. Double-click **Add/Remove Programs** (or click **Uninstall a program**).
3. Select **HP Photosmart All-In-One Driver Software**, and then click **Change/Remove**.
   Follow the onscreen instructions.
4. Disconnect the product from your computer.
5. Restart your computer.

**NOTE:** It is important that you disconnect the product before restarting your computer. Do not connect the product to your computer until after you have reinstalled the software.
6. Insert the product CD-ROM into your computer's CD-ROM drive and then start the Setup program.

**NOTE:** If the Setup program does not appear, locate the setup.exe file on the CD-ROM drive and double-click it.

**NOTE:** If you no longer have the installation CD, you can download the software from [www.hp.com/support](http://www.hp.com/support).

7. Follow the onscreen instructions and the instructions provided in the printed documentation that came with the product.

When the software installation is complete, the **HP Digital Imaging Monitor** icon appears in the Windows system tray.

---

**Print troubleshooting**

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

- **Check cartridges**
- **Check paper**
- **Check product**
- **Check printer settings**
- **Reset the product**
- **Contact HP support**

**Check cartridges**

Try the following solutions.

- **Step 1: Make sure you are using genuine HP ink cartridges**
- **Step 2: Check the ink levels**

**Step 1: Make sure you are using genuine HP ink cartridges**

**Solution:** Check to see if your ink cartridges are genuine HP ink cartridges.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges are designed and tested with HP printers to help you easily produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

Cause: Non-HP ink cartridges were being used.
If this did not solve the issue, try the next solution.

Step 2: Check the ink levels

Solution: Check the estimated ink levels in the cartridges.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not need to replace the cartridges until print quality becomes unacceptable.

For more information, see:

Check the estimated ink levels

Cause: The ink cartridges might have insufficient ink.
If this did not solve the issue, try the next solution.

Check paper

Try the following solutions.

• Step 1: Make sure only one type of paper is loaded
• Step 2: Load the stack of paper correctly

Step 1: Make sure only one type of paper is loaded

Solution: Load only one type of paper at a time.

Cause: More than one type of paper was loaded in the paper tray.
If this did not solve the issue, try the next solution.
Step 2: Load the stack of paper correctly

Solution: Remove the stack of paper from the paper tray, reload the paper, and then slide the paper-width guide inward until it stops at the edge of the paper.

For more information, see: Load media

Cause: The paper-width guide was not positioned correctly.

Check product

Try the following solutions.

- Solution 1: Align the print cartridges
- Solution 2: Automatically clean the print cartridges.

Solution 1: Align the print cartridges

Solution: Aligning the print cartridges can help ensure high-quality output.

To align the print cartridges from the HP Photosmart Software
1. Load letter or A4 unused plain white paper into the paper tray.
2. In the HP Solution Center, click Settings.
3. In the Print Settings area, click Printer Toolbox.

The Printer Toolbox appears.
4. Click the Device Services tab.
5. Click Align the Print Cartridges.
6. Click Align, and then follow the onscreen instructions.
   The HP Printer prints a test page, aligns the print cartridges, and calibrates the printer. Recycle or discard the test page.

Cause: The printer needed to be aligned.

If this did not solve the issue, try the next solution.

Solution 2: Automatically clean the print cartridges.

Solution: Clean the print cartridges.

For more information, see Automatically clean print cartridges

Cause: The print cartridge nozzles needed to be cleaned.

If this did not solve the issue, try the next solution.
Check printer settings

Try the following solutions.

• **Step 1: Check the print settings**
• **Step 2: Verify the paper size setting**
• **Step 3: Check the printer margins**

**Step 1: Check the print settings**

**Solution:** Check the print settings.

• Check the print settings to see if the color settings are incorrect. For example, check to see if the document is set to print in grayscale. Or, check to see if advanced color settings such as saturation, brightness, or color tone, are set to modify the appearance of colors.

• Check the print quality setting and make sure it matches the type of paper loaded in the product. You might need to choose a lower print quality setting, if colors are running into each other. Or, choose a higher setting if you are printing a high-quality photo, and then make sure photo paper such as HP Advanced Photo Paper, is loaded in the paper tray.

**NOTE:** On some computer screens, colors might appear differently than they do when printed on paper. In this case, there is nothing wrong with the product, print settings, or ink cartridges. No further troubleshooting is required.

**Cause:** The print settings were set incorrectly.

If this did not solve the issue, try the next solution.

---

**Step 2: Verify the paper size setting**

**Solution:** Verify that you have selected the proper paper size setting for your project. Make sure that you have loaded the correct paper size in the paper tray.

**Cause:** The paper size setting might not have been set correctly for the project you were printing.

If this did not solve the issue, try the next solution.

---

**Step 3: Check the printer margins**

**Solution:** Check the printer margins.
Make sure the margin settings for the document do not exceed the printable area of the product.

**To check your margin settings**
1. Preview your print job before sending it to the product. In most software applications, click the File menu, and then click **Print Preview**.
2. Check the margins. The product uses the margins you have set in your software application, as long as they are greater than the minimum margins the product supports. For more information about setting margins in your software application, see the documentation that came with the software.
3. Cancel the print job if the margins are not satisfactory, and then adjust the margins in your software application.

**Cause:** The margins were not set correctly in your software application. If this did not solve the issue, try the next solution.

---

**Reset the product**

**Solution:** Turn off the product, and then unplug the power cord. Plug the power cord back in, and then press the On button to turn on the product.

**Cause:** The product experienced an error. If this did not solve the issue, try the next solution.

---

**Contact HP support**

**Solution:** Contact HP support for service.

Go to: [www.hp.com/support](http://www.hp.com/support).

If prompted, choose your country/region, and then click **Contact HP** for information on calling for technical support.

**Cause:** The ink cartridges were not intended for use in this product.

---

**Errors**

This section contains the following categories of messages about your product:

- **Flashing lights**
## Flashing lights

The lights on the product flash in special sequences to inform you about various error conditions. Refer to the following table for information on solving your error condition based on which lights are on or flashing on the product.

<table>
<thead>
<tr>
<th>On light</th>
<th>Message displayed Onscreen</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Product Disconnected!</td>
<td>Press the On button to turn the product on.</td>
</tr>
<tr>
<td>Normal blinking</td>
<td>Your product is ready.</td>
<td>The product is processing a job. Wait for the product to finish.</td>
</tr>
<tr>
<td>Fast blinking</td>
<td>The printer is out of paper.</td>
<td>The product is out of paper. Load paper and press On button.</td>
</tr>
<tr>
<td></td>
<td>Paper jam</td>
<td>The product has a paper jam. Clear the paper jam, and then press On button.</td>
</tr>
<tr>
<td></td>
<td>There is a paper jam (or misfeed). Clear the jam and press the On button on the printer.</td>
<td></td>
</tr>
<tr>
<td>Fast blinking</td>
<td>Cover open</td>
<td>The front access door is open. Close the front access door.</td>
</tr>
<tr>
<td></td>
<td>The cover is open.</td>
<td></td>
</tr>
<tr>
<td>Fast blinking</td>
<td>Cartridge(s) Missing</td>
<td>The print cartridges are missing or not seated correctly. Install or remove and reinsert print cartridges.</td>
</tr>
<tr>
<td></td>
<td>The following cartridge appears to be missing, not detected, or incorrectly installed: Tricolor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td>The tricolor or black print cartridge might be installed in the wrong slot. Remove and reinsert the tricolor or black print cartridge print cartridge in the correct slot.</td>
</tr>
<tr>
<td></td>
<td>The following cartridge appears to be missing, not detected, or incorrectly installed: Black</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td>The tape was not removed from one or both print cartridges. Remove the print cartridge, remove tape, and reinsert the print cartridge.</td>
</tr>
<tr>
<td></td>
<td>The following cartridge appears to be missing, not detected, or incorrectly installed: Tricolor OR Black</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Low on Ink</td>
<td>Print cartridges are getting low on ink.</td>
</tr>
<tr>
<td></td>
<td>Tricolor</td>
<td>HP recommends you have a replacement available to install when print quality is no longer acceptable. Click &quot;Help&quot; for more information.</td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The following cartridge is low on ink:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Black</td>
<td></td>
</tr>
</tbody>
</table>
## On light

<table>
<thead>
<tr>
<th>Message displayed Onscreen</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP recommends you have a replacement available to install when print quality is no longer acceptable. Click &quot;Help&quot; for more information.</td>
<td></td>
</tr>
</tbody>
</table>

### Ink Alert

The following cartridge has been sufficiently depleted to cause poor print quality:

- **Tricolor**

HP recommends you have a replacement available to install when print quality is no longer acceptable.

**OR**

The following cartridge has been sufficiently depleted to cause poor print quality:

- **Black**

HP recommends you have a replacement available to install when print quality is no longer acceptable.

### Fast blinking

**Single Ink Cartridge Mode**

*Note: Your printer may come with one ink cartridge.*

In this single cartridge mode, the printer may print more slowly, and printed colors may differ from those you would see with all of the cartridges.

Replace one or both print cartridges when print quality is no longer acceptable.

### Fast blinking

**Cartridge(s) Problem**

At least one of the cartridges has a problem. Click “Help” for more information.

The print cartridge(s) may be defective.

1. Remove black print cartridge.
2. Close door.
3. If the **On** light is still blinking, replace the tricolor print cartridge. If the **On** light is not blinking, replace the black print cartridge.

The cartridge cradle cannot move. Please turn device power off. Check device for a paper jam or other obstruction.

The print carriage is stalled.

Open the front access door, and check that the carriage is not blocked.
<table>
<thead>
<tr>
<th>On light</th>
<th>Message displayed Onscreen</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast blinking</td>
<td>None</td>
<td>The product has a fatal error.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Turn off the product.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Unplug the power cord.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Wait a minute, then plug the power cord back in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Turn on the product.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact HP Support.</td>
</tr>
</tbody>
</table>
7 Stop the current job

To stop a print job from the HP Printer

▲ Press On button on the control panel. If the print job does not stop, press On button again.

It can take a few moments for printing to be cancelled.
Stop the current job
8 Technical information

The technical specifications and international regulatory information for the HP Printer are provided in this section.
For additional specifications, see the printed documentation that came with the HP Printer.
This section contains the following topics:

- Notice
- Specifications
- Environmental product stewardship program
- Regulatory notices

Notice

Hewlett-Packard Company notices

The information contained in this document is subject to change without notice.
All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior written permission of Hewlett-Packard, except as allowed under copyright laws. The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
© 2009 Hewlett-Packard Development Company, L.P.
Windows Vista is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Specifications

Technical specifications for the HP Printer are provided in this section. For complete product specifications, see the Product Data Sheet at www.hp.com/support.

System requirements

Software and system requirements are located in the Readme file.
For information about future operating system releases and support, visit the HP online support Web site at www.hp.com/support.

Environmental specifications

- Recommended operating temperature range: 15 ºC to 32 ºC (59 ºF to 90 ºF)
- Allowable operating temperature range: 5 ºC to 40 ºC (41 ºF to 104 ºF)
- Humidity: 15% to 80% RH non-condensing; 28 ºC maximum dewpoint
- Non-operating (Storage) temperature range: –40 ºC to 60 ºC (–40 ºF to 140 ºF)
- In the presence of high electromagnetic fields, it is possible the output from the HP Printer may be slightly distorted
- HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise due to potential high electromagnetic fields

Paper tray capacity

Plain paper sheets: Up to 80

Paper size

For a complete list of supported media sizes, see the printer software.

Paper weights

Letter Paper: 75 to 90 g/m² (20 to 24 lb)
Legal Paper: 75 to 90 g/m² (20 to 24 lb)
Envelopes: 75 to 90 g/m² (20 to 24 lb)
Cards: Up to 200 g/m² (110-lb index maximum)
Photo Paper: Up to 280 g/m² (75-lb index maximum)

Print resolution
To find out about the printer resolution, see the printer software. For more information, see View the print resolution.

Cartridge yield
Visit www.hp.com/go/learnaboutsups for more information on estimated cartridge yields.

Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to: www.hp.com/support.

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for recycling has been incorporated into this product. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment Web site at: www.hp.com/hpinfo/globalcitizenship/environment/index.html

This section contains the following topics:
- Eco-Tips
- Paper use
- Plastics
- Material safety data sheets
- Recycling program
- HP inkjet supplies recycling program
- Power consumption
- Disposal of waste equipment by users in private households in the European Union
- Chemical Substances
- Toxic and hazardous substance table

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-Tips below to help you focus on ways to assess and reduce the impact of your printing choices. In addition to specific features in this product, please visit the HP Eco Solutions web site for more information on HP’s environmental initiatives.
Your product's Eco features

• **Smart Web printing**: The HP Smart Web Printing interface includes a **Clip Book** and **Edit Clips** window where you can store, organize, or print clips you have gathered from the Web. For more information, see [Print a Web page](http://www.hp.com/hpinfo/globalcitizenship/environment/).
• **Energy Savings information**: To determine the ENERGY STAR® qualification status for this product, see [Power consumption](http://www.hp.com/hpinfo/globalcitizenship/environment/).
• **Recycled Materials**: For more information regarding recycling of HP products, please visit: [www.hp.com/hpinfo/globalcitizenship/environment/recycle/](http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/)

Paper use

This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets

Material safety data sheets (MSDS) can be obtained from the HP Web site at: [www.hp.com/go/msds](http://www.hp.com/go/msds)

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and partners with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling some of its most popular products. For more information regarding recycling of HP products, please visit: [www.hp.com/hpinfo/globalcitizenship/environment/recycle/](http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/)

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more information, go to the following Web site: [www.hp.com/hpinfo/globalcitizenship/environment/recycle/](http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/)

Power consumption

Power usage drops significantly while in Sleep mode, which saves natural resources and saves money without affecting the high performance of this product. To determine the ENERGY STAR® qualification status for this product see the Product Data Sheet or Specifications Sheet. Qualified products are also listed at [www.hp.com/go/energystar](http://www.hp.com/go/energystar).
Disposal of waste equipment by users in private households in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with your household waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. These collection points are easily accessible for all private households. For more detailed information on the location of the collection points for electrical and electronic waste, please contact your local city office, your household waste disposal service or the shop where you purchased the product.

Disposal of waste electrical and electronic equipment (WEEE) in the European Union

Illegal disposal of equipment by users in private households in the European Union

Illegal disposal of equipment by users in private households in the European Union

Toxic and hazardous substance table

<table>
<thead>
<tr>
<th>零件描述</th>
<th>有毒有害物质和元素</th>
<th>焦</th>
<th>杂</th>
<th>铅</th>
<th>六价铬</th>
<th>多氯联苯</th>
<th>多溴联苯醚</th>
</tr>
</thead>
<tbody>
<tr>
<td>外壳和托盘*</td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>电缆*</td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>印刷电镀纸*</td>
<td></td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>打印头盒*</td>
<td></td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>喷墨打印机墨盒*</td>
<td></td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>理论文件*</td>
<td></td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>电源线*</td>
<td></td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>自动双面打印系统*</td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>外壳电镀*</td>
<td></td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

0: 指该部件的所有均一材料中不含的这种有毒有害物质，含量小于SJ/T11363-2006的限制
X: 指该部件的均一材料中至少有一种包含的这种有毒有害物质，含量大于SJ/T11363-2006的限制

Regulatory notices

The HP Printer meets product requirements from regulatory agencies in your country/region. This section contains the following topics:

- Regulatory model identification number
- FCC statement
- Notice to users in Korea
- VCCI (Class B) compliance statement for users in Japan
- Notice to users in Japan about the power cord
- HP Deskjet D1600 Printer series declaration of conformity

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is SNPRB-0921-01. This regulatory number should not be confused with the marketing name (HP Deskjet D1600 Printer series, etc.) or product numbers (CH358, etc.).
The United States Federal Communications Commission (in 47 CFR 15.105) has specified that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)

The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by HP may void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Notice to users in Korea

B 급 기기(가정용 방송통신기기)
이 기기는 가정용(B급)으로 전자파적합등록을 한 기기로서 주로 가정에서 사용하는 것을 목적으로 하며, 모든 지역에서 사용할 수 있습니다.

VCCI (Class B) compliance statement for users in Japan

この装置は、情報処理装置等電波障害自主規制協議会（VCCI）の基準に基づくクラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると受信障害を引き起こすことがあります。
取り扱い説明書に従って正しい取り扱いをして下さい。
Notice to users in Japan about the power cord

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。
DECLARATION OF CONFORMITY
according to ISO/IEC 17050-1 and EN 17050-1

Supplier’s Name: Hewlett-Packard Company
Supplier’s Address: 60, Alexandra Terrace, # 07-01 The Comtech, Singapore 118502
DoC#: SNPRB-0921-03-A

declares, that the product

Product Name: HP Deskjet D1600 Series
Regulatory Model Number: SNPRB-0921-03
Product Options: All

conforms to the following Product Specifications and Regulations:

SAFETY:

EMC:
CISPR 22:2005 / EN55022:2006 Class B
FCC CFR 47, Part 15 Class B / ICES-003, Issue 4 Class B

Supplementary Information:
1. For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product name or the product number(s).
3. This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
4. The product was tested in a typical configuration.

Singapore
22 September 2008

Local contact for regulatory topics only:
USA : Hewlett-Packard, 3000 Hanover St., Palo Alto 94304, U.S.A. 650-857-1501
Index

A
after the support period 34

C
connection problems
  HP All-in-One will not turn on 35
customer support
  warranty 34

E
environment
  Environmental product stewardship program 50
  environmental specifications 49
  error messages 42

I
ink-backup mode 31

P
dpaper
  recommended types 21
  phone support 33
  phone support period
    period for support 33
  print
    troubleshooting 38
  printing
    with one print cartridge 31
  problems
    error messages 42
    print 38

R
recycle
  ink cartridges 51
regulatory notices
  regulatory model
    identification number 53
reinstall software 37

S
software installation
  reinstall 37
  uninstall 37
support process 33
system requirements 49

T
technical information
  environmental specifications 49
  system requirements 49
troubleshoot
  setup 34
troubleshooting
  error messages 42
  print 38

U
uninstall software 37

W
warranty 34